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APRESENTACAO

O FINALE é um software para edicao de partituras desenvolvido pela Coda
Music and Technology/Smart Music. O programa oferece diversos recursos que
torna possivel escrever uma partitura por completo, reproduzir, gravar e imprimir.

Para o profissional da musica e, especificamente, o professor de masica, o
FINALE é mais uma ferramenta que pode auxiliar a edicdo ou editoracdo de
composicdes, arranjos, exercicios e até como ferramenta para o préprio estudo
musical.

Nesta apostila, ainda em desenvolvimento, vocé encontrara informacgdes
bésicas sobre o FINALE 2014 que tem como propdsito facilitar o aprendizado
dos diversos recursos disponiveis no programa e auxiliar seus estudos na
disciplina de Novas tecnologias e Educacdo Musical apresentando 0s recursos
estudados em cada aula.

Caso queira ir além, complemente seus estudos com outros materiais e a
pratica constante. No final da apostila disponibilizamos algumas referéncias, lista

de atalhos e glossario das ferramentas e termos.

Bons estudos!
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ABRIR, SAIR E SALVAR

COMO ABRIR O PROGRAMA

V7%
Para abrir o programa, clique no icone do Finale 2014 @ eo

programa sera iniciado.

Uma tela inicial ir4 aparecer.
% e

— ﬂ
: :
| [ oo |
[ousroocumesn [ rceosewiso | =

TEMPLATES IMPORT MUSICXML

Learning Center

QuickStart Videos Tip of the Day (<>

Finale now indudes the abilty to create truly keyless scores. You can also assign
User Manual blank key signatures to sections of a document or individual staves.

Tutorial Guide

Creating SmartMusic® Files

Observacdo: Antes de dar sequéncia e demonstrar os recursos desta
janela, confira outros comandos bésicos: Sair, Salvar e Abrir arquivos quando

0 programa ja estiver aberto.

File @fdit Ufiities View Document MIDI/Audio  Tool:
Lo Wndow... Ctrl+Shift+N I

COMO SAIR .y w0 R

Open Worksheets & Repertoire...

Close Chrl +4if

Para sair do Finale: Close Al

Sawe Ctrl+S
Save fis. .
Sawe Al

1. Clique no icone _#_ no canto superior direito. ="
Ou !S:‘:r::tdelger... ’
Export >

2. Na barra de menu File (arquivo), deslize o ...

Sawve Librang.,

mouse até o item Exit (sair) e clique sobre ele. PrinterPage Setyp..

Print... Ctrl+P

Compile PostScript Listing...

Save Preferences ﬁ

1 C\Users\,..\exercicio em c

2 exercicio de novas tecnologias
3 Prova de novas tecnologias _ kadja

4 prova_kadja
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COMO SALVAR

Para Salvar um documento:

Clique em File > Save ou utilize o atalho Ctrl+S.

m h ilities View Document MIDI/Audio Tools Plug-ins Window Help

Laun¥h Windo Ctrle Shift=N
aun® Window... trl+ + e W‘ " Cw’ ‘
New ¥ =
JE Open... Ctrl+Q ©=peat: 1 Time: 00:00:00.000 = ‘rl
j‘ Open Worksheets & Repertoire...
‘I Close Ctrl+W
< Close All
7 e
Save As.. Exercicio ¢
Save All .
J  Btectpars. Subtitle
Revert...
J ScoreMerger...
Import 4 : I
Export &~ = z
- |
Load Library... —
ﬁ Save Library...
j E — 1 s
[ Printer Page Setup... , i i
Print... Ctrl+P
Compile PostScript Listing...
Save Preferences
Exit Alt+F4 - ] —
— =
& 1O\ Tlear\ Navarcicia am ~ =l e T

Na primeira vez ira aparecer uma nova janela e nela vocé deve escolher o

local onde o arquivo sera salvo.
MTEJJ d MY = o w1 \-M‘bl'ﬂ'u‘\_/“\‘

® » W[ 110000 2| Repeat: 1 Time: 00:00:00.000 =\f120 f‘ P A I I R |

Salvarem: | [ Area de Trabaho v @%@

L
o~ Q% Grupo doméstico )i Karla
Locais recentes
—— u nome

A 2&} Meu computador _ | Bibliotecas ”aﬂgﬁ'd
-‘ ™ s

Area ae
Trabalho | Rede [r apostila 2014 andamento T
= B> cravoecanela B eercidoemc
=g + Finale Notation File Finale Notation File
Bibliotecas  F g0 = o
rs
Y
A
Meu
computador 0 1 0 2 l:.'
@ Nome: |Brercicio v [ sabvar | E
Rede - :
P; Tipo: | Finale Notation File (*musx) v| | Cancelar |
[ v | :

Em nome, escreva o titulo da musica. E em tipo, pode-se escolher o tipo
de arquivo em que deseja salvar a musica criada.
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.mus para o formato do programa finale, e
.mid para arquivos de audio em formato midi.

ABRIR ARQUIVOS

Na barra de menu, cligue em File Open ou utilize o atalho Crtl+O.

E,

'1“ lities  View Document MIDIfAudic Tools Plug-ins  Window Help
Launch Window... Ctrl+Shift+ M I E = mf " |

- O

=peat: 1 Time: 00:00:00.000

Open Worksheets & Repertoir

Cloze Ctrl+W
Close All

Save Ctrl+5
Save As... Exer(
Sawve All
Extract Parts...
Revert...

T o olFEl-I=

ScoreMerger...

L

Import L4 I

Ira aparecer uma janela (Open), e nela deve-se escolher o arquivo

desejado em uma determinada pasta. Apds localizado, clique em Abrir.

S i - . e gy | = —- - = wegm
& x
Examinar: I!.f\rea de Trabalho v| (< NN
e
.ri"y Q% Grupo doméstico ] Karla
Locais recentes
o u no:
]Q] Meu computader | Bibliotecas Tramn;
Area d’e o=
Trabalho @I Rede F[‘ apostila 2014 andamento E
--_T B> cavoecanela BP eercicoem ¢
= Finale Notation File Finale Notation File
Bibliotecas | 5210 ke
Meu 1 2
computador
@' Nome: ‘u—:lvuecanela v ‘ Pbrir
Rede
P Tipo | Al Readable Fies v| | cancslar |
°

Se desejar abrir um arquivo em formato Midi, escolha a op¢ao Midi File em

Tipo.
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CONFIGURACOES INICIAIS

TELA INICIAL (LAUNCH WINDOW)

Ao iniciar o programa Finale 2014 ira aparecer uma tela inicial Launch
Window. Ela reane algumas fun¢des do programa que irdo facilitar na escrita da

sua partitura. Confira a imagem abaixo:

-
]

SETUP WIZARD SCANNING OPEN

DEFAULT DOCUMENT EXERCISE WIZARD |[berA1 Recent File W |

| #Documento padrao B .. Abrir arquives recentes
ﬁAs.ﬂste nte de exercicio 1
TEMPLATES IMPORT MUSICXML

tipos de documentos ﬁ Importar arquivos
Learning Center

QuickStart Videos Tip of the Day (<>

Finale now includes the ability to create truly keyless scores. You can also assign
User Manual blank key signatures to sections of a document or individual staves.

Videos

Tutorial Guide Manual
¢ Tutorial

‘ @i
Creating SmartMusic® Files : Criar documentos Smart
Music
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Quando aparecer a janela, clique em Setup Wizard.

finale.

sevrwaseo | scawre [ oo
DEFAULT DOCUMENT EXERCISE WIZARD Open Recent File v
TEMPLATES IMPORT MUSICXML

Learning Center

QuickStart Videos Tip of the Day (<> |

Want hairpins to follow your notes as you edit your score? Many Smart Shapes
User Manual are now beat-attached instead of measure-attached, operating like expressions
or articulations.

Tutorial Guide

Creating SmartMusic® Files

Ira aparecer a janela “Document Setup Wizard”. Nela pode-se definir a o

tipo do documento referente ao estilo musical (coro, quarteto de sopro, trios,

orquestra e etc) e definir o tipo do papel (A4, Carta e etc).

DEFININDO ESTILO MUSICAL E PAGINA

Para efeito de aprendizagem, iremos utilizaremos

Create New Ensemble (criar um novo estilo) > Engraved Style (estilo

gravado), e em

Score Page Size (tamanho da pagina) e Part Page Size (tamanho da

parte) utilizaremos o formato da pagina A4 e Portait (retrato).

Acompanhe o passo a passo:



TELA INICIAL (LAUNCH WINDOW)

Select an Ensemble: Select a Document Style:
Engraved Style Engraved Style (Maestro Fort)

Handwritten Style .
SATB+Piano Band Finale’s all-purpose document style

Brass Trio Choral
General
Orchestral

* Title, Subtitle, Composer, Amanger,
Score/Part, and Copyright text

Bai inserts
Concert Band (Full}
Woodwind Trio
Woodwind Quirtet
Waoodwind Choir
String Quartet Always Use This Document
Orchestra (String) Style with the Selected
Orchestra (Full) Ensemble

Delete

Score Page Sizs: | Ad (8,26736x 11,69444)
@ Portrait O Landscape

Part Page Size: Letter (8,5 11)
Letter (8,5 11)
Legal (8.5x 14) 0 4

Tabloid (11x 17)

B4 {10.13885x 14,

A3 (11,6875 16,53125)
Statement (5.5 8,5)
Hymn (5,75 8,25)
Cctavo (6.75x 10.5)
Executive {7.5x 10}
Quarto (8,5x 10,79861)

Apés clicar em Avancar, ira aparecer a janela Add or Delete Instruments
(adicionar ou deletar instrumentos), nela iremos adicionar os instrumentos da

partitura.

instrumento
partitura
-

3 N

Voices Harpsichord
Woodwinds Organ Add >
Bross Oraan (2stsf) | Add>
Strings Celesta )

Plucked Strings Accordion < Remave

Tablature Melodica

Pitched Percussion Blectric Piano Q
Drums Clavinet cal
Percussion Synth Pad I%rrﬂin‘é'mlca 5

Synth Lead trufiéhto Setas para organirzlr

Synith Brass 07
Synth Soundtrack icionado ordem dos instru

Sound FX na partitura
Harmanium

Ondes Martenat

¥ Instrumentos
selecionados

| Orchestral v/

Ensemble

gru:::mti:r:nble Save Cument Ensemble | Save as New Ensemble... |

1]
<Votar || Avangar> | | Cancelar |

Acompanhe o0 passo a passo criar uma partitura para Piano e Voz.



TELA INICIAL (LAUNCH WINDOW)

Observacao: Para deletar um instrumento é sé clicar no instrumento
correspondente no ultimo retédngulo da direita e clicar no botdo Remove.

Para que a partitura siga a sequencia tradicional da primeira pauta ser da
voz e as demais do piano, devemos inverter a ordem clicando nas setas.

Quando tiver adicionado ou deletado todos os instrumentos que ira compor
a partitura e ordenado a sequéncia clique em Avancar.

INFORMACOES SOBRE A PARTITURA

Apos clicar em avancar na janela Add or Delete Instruments, ira aparecer
a janela Score Information em que devemos inserir informacfes sobre a

partitura:
Title (Titulo da musica) e Subtitle (subtitulo);
Composer (compositor);
Arranger (arranjador);
Lyrics (letra), e
Copyright (direitos autorais).

Exemplo:
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l Document Setup Wizard - Score Information \E\]
Title:
Subtitle: Loaks likke December -
Composer: Antonio Caros Jobim & Chico Buarque - 1
Amanger:  Paulo Jobim .

; Lyricist: -

t -

4

4
Copyright: -

< Voltar ][ Avangar > ] [ Cancelar

DEFININDO FORMULA DE COMPASSO, ARMADURA DE CLAVE,
ANDAMENTO E ANACRUSE

Na janela Score Settings, pode-se definir a férmula de compasso,

armadura de clave, andamento e anacruse. Observe:
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- o

Document Setup Wizard - Score Settings @
Formula de Compasso Andanento
Select a Time Signature [7] Spécify Initial Tempo Marking
3¢|1[8]% ¢ e

g g g lg g ‘ Tempo: :J = 120
Armadura de Clave O Anacruse
Sefect a Concert Key Signature [ Specify Pickup Measure
h F
g e il
ajor -
S ‘ o o[ L& [ D] 5[ 8]
DI Major -

Mumber of Measures: 31

ﬁNL’Jmeru de Compassos

< Voltar ” Concluir ] [ Cancelar

Em Select a time Signature (Selecdo da Férmula de Compasso), cliqgue

na formula de compasso desejada.

Cliqgue
com botao

Select a Time Signature U esquerdao.

glelq|%| %
333"&3_‘

Formula de Compasso

Em Select a Key Signature, escolha a Armadura de Clave desejada,
clicando na seta para cima para escolher as tonalidades com sustenidos e na

seta para baixo para escolher as tonalidades com bemais.

Se a tonalidade desejada for menor, mude a opcao Major Key para Minor
Key.
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Armadura de Clave

ect a Concert Key Signatu sustenido
n:?) Maior ou
h Menor.
Maijor
& C Major Mooy |

ﬁ bemaol

Em Number of Measure, indique a quantidade de compassos desejada na

partitura.

Observacéao: Depois pode-se adicionar ou apagar 0S compassos

Mumber of Measures: 31

ﬁNL:ImEFD de Compassos

Em Specify Initial tempo Marking, marque a caixa com o clique com o
botdo esquerdo, indique o texto e 0 andamento.

Specify Inttial Tempo Marking

ﬁl Tent: @2
Tempo: ¢J = 120 <:
3

Se a musica tiver um compasso em Anacruse, marque o item Specify
Pickup Measure e escolha a figura que representa a quantidade de tempos

contidos no compasso Anacruse.

Specify Fickup Measure
ﬁ Quantidade de tempos

clique gl J| IJ ﬁ ﬁ ﬁ
Il o J | J | J.J ﬁ ﬁ ﬁ
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Observacado: Ha uma outra maneira de fazer Anacruse, veja na pagina 40.

Apos todas as definices clique em Concluir e entdo a partitura ira aparecer.

Veja o0 exemplo abaixo das configuracdes iniciais de uma partitura:

©) Finale 2010a - [Untitled]] SRR

[{] File Edit Utilities View Document MIDVAudio Plug-ins Tools Window Help [<]=]x]

EEEEzERRSaiExEdwAAxb N scd@ED X
HEHiE §~ N @i [11110000 |- Repeat: [+ ~| Tme: 00:00:00.000 EJT%E"
| o o Tl I T e G I o o EEEEEEEEE\E

S 55 7 ) R ] B B I B 1 B B

Anos dourados
Looks like December

Antonio Carlos Jobim & Chico Buarque
Paulo Jobim

Soprano

1

h.

%>§ e@taﬂ

B2EE_Pace: 4[4 1
SELECTION TOOL: Click an object to select it; Drag an object to move it; Double-click an object to go to its editing tool.
] S ] R || | =] U | |

[ m \

8=z
=
<




INTERFACE PRINCIPAL

INTERFACE PRINCIPAL

ApoOs a configuracdo inicial na janela Launch Window ira aparecer a Interface

Principal do Finale.

‘ LI = -‘ > 2 b dMe 3 = 35 o ] w L T % D J Q @Barradeierramentas
‘)’ 7Y @ ,,,,,, E K Im « B P Il & » »1] 1000 % | Repeat: 1 Time: oouuooooom 100 .

7 = <J E> DI ]
" Bafra de Ferramentas Barra de ferramentas
e - 1"
ol | -
Cravo ¢ canela *
o 2 b
J - Milton Nascimento e Ronaldo Bastos Jt
J | 7 a 5
ER AR N e i So===—_—==a——=_ 7
s o | B>\ ATy si et i g it :
) Piano = ~ = S, = ~ ~— — = B =
arra |ae
) Y ]
= 3 i i = i i i =) i verticpl
- - 4
) )
. A 7
“ IA gll l- = | - Al w T ﬁ IHII i | ﬂ’
v e led T e P e o i
b D)} == == B8
g 5 =
% o It
7 E ) e e e S B e S e 8 S e B e B e B e S e
Vozes 7 o e e e e e s i e e e e "
5 e, [l iR AR 33 P393 333 A0 s S0 es %
& G I I I | 5
e O il I T 1 T 1 T 1
- iR = e = v
Pl [iﬂ,z 34| Page: 14 4 1\/ P < I 2o : >

HAND GRABBER TOOL: Draa the music to adiust vour view.

BARRAS DE FERRAMENTAS

As barras de Ferramentas sédo Uteis pois servem de atalho para os
principais recursos do programa, para escrever a partitura utilizando o mouse,

para tocar a musica dentre outros.

MOVENDO AS BARRAS DE FERRAMENTAS

Para mover as barras de ferramentas, clique e segure com o0 botdo
esquerdo do mouse no inicio da barra ferramenta e arraste para o lugar

desejado, quando encaixar é s6 soltar o botdo do mouse.



ADICIONANDO OU REMOVENDO AS BARRAS DE FERRAMENTAS

Caso as barras de ferramentas nao Tees: Psmwp
= F3 ScoreManager Ctrl+K a

1 1 Mixer Ctrl+Shift+M
estejam aparecendo, clique no menu e indon e o
Window e em seguida cligue na barra de e
ferramenta  desejada  para  ativar. - D

¥ Simple Entry Palette
Acompanhe o passo a passo ao lado. v Simple Entry Rests Palette
Smart Shape Palette Hscin
v Special Tools Palette
Outra maneira de fazer é clicando com — e
~ . . , . Arrange lcons
0 botdo direito em uma area vazia da barra Cascade Windows =
i Tile Windows Vertically T
de ferramenta e ativar a barra de ferramenta Tile Windows Horizontally =
MNew Window
dESEJada Close Window %
v 1 cravoecanela.musx
™~ —

Observacgéao: Para desativar a barra de ferramenta deve-se fazer o mesmo

processo.
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ESCREVENDO PARTITURAS

Pode-se escrever a partitura de trés maneiras: pelo teclado do computador,

pelo mouse e por um teclado midi.

Nesta apostila daremos énfase a escrita pelo mouse, entretanto alguns

atalhos serao citados.

ESCREVENDO NOTAS E PAUSAS

Para escrever as figuras de notas, acidentes de alteracdo, ligadura,

apogiatura, tercina ... utiliza-se a barra de ferramenta Simple Entry Palette.

- T P I

Para escrever pausas, utiliza-se a barra de ferramentas Simple Entry
Rests Palette.

Para escrever na partitura € so clicar na figura desejada na barra de
ferramenta Simple Entry Palette ou Simple Entry Rests Palette na pauta clicar

na linha ou espaco desejado com o botéo esquerdo. Acompanhe:



ESCREVENDO PARTITURAS

)
) File Edit Utilities View Document MIDI/Audio Tools Plug-ins Simple Window Help

st sallom =35 w ) w LT % DO a
&3 Q ) ﬂ’?’m B K ‘I;« “« H > il & » »1‘ 1] 10000 % | Repeat: 1 Time: 00:00:00.000 = 120 :

o

Score

Title

Composer
1 2

-a-»»»\amo—o T o »
BT O TR I T I |

T 9 X5 T wg & o b

rr—F
C@‘N)b
o

st

B
=
&

Y% -
. "5 : : : . 2zl
& ES ] : ! ! N

> [123]4] Page: 14 4] 1 MM < >
Observacoes:

e Caso as barras de ferramentas néo estejam expostas deve-se ativar
no meu Window, como explicado na pagina 23.
e Observe que antes de clicar na pauta a figura (nota ou pausa) fica

na cor cinza, a Ultima nota na cor rosa e a nota ja escrita em azul.

APAGANDO NOTAS E PAUSAS

: ] = 4
Para apagar uma nota ou pausa, clique no icone — Eraser na barra de

ferramenta Simple Entry Palette. e cligue na cabeca da nota ou na pausa
desejada na partitura.
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ACIDENTES

Para escrever os acidentes deve-se clicar na figura de nota, em seguida no

icone correspondente ao acidente na barra de ferramenta e na pauta.

f]FiIe Edit Utilities View Document MIDI/Audio Tools Plug-ins Simple Window Help i
r 4=t oa@l>M =35 % w LT %D|Oal
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B Score )
: Title
"
Composer
7
§ 2
fH I | I |
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' e | i
§ D} ] I
o3
0
7 ] ] ] :
:® T {0 T 1
L2

Para fazer o duplo sustenido é sé clicar na tecla + (mais) e o duplo bemol

a tecla - (meno).

Observacao: Lembre-se de desmarcar o acidente.
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FERRAMENTA REPITCH TOOL

Muito Util na escrita da partitura, a ferramenta Repitch Tool, ajusta a altura

da nota.

e

Para utiliza-la dé um clique no icone _¥_ localizada na barra de ferramenta
Simple Entry Palette e clica na cabeca da nota que deseja alterar. Em seguida

clica na linha ou espaco que deseja colocar a nota.

n = = > =5 > M =35 m | w LT %

& & Ggﬁu@»& |>««l>ll 0»m|11::=:u:~:
sBlw o J 4 b N XN N - & b b oss oy

- Repeat: 1

| o

Score

Title

r  -Tep ~XP - o ]

A mudanca na altura da nota também pode ser feita apés o clique na

cabeca da nota utilizando as setas do teclado 1 e |.

Observe que had uma marcagdo na cor cinza indicando a posi¢édo onde

ficara a nota apoés o clique.

ESCREVENDO ACORDES

Para escrever um acorde € sO sobrepor as notas. Por exemplo: Para
escrever um acorde de D6 maior com semibreves. Primeiro clica na figura

desejada e em seguida na pauta as notas que compdem o acorde: D6, Mi e Sol.
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ESCREVENDO MAIS DE UMA VOZ

Em uma partitura para coral ou para instrumentos harménicos como o piano
ou violdao em que as vozes acontecem simultaneamente, costuma-se dividir a

escrita em vozes. Veja o exemplo abaixo:

BWY 1.6 Wie Schon leuchet der Morgenstern

J.S Bach

P 1 | | | =] [ X
e = s $ 33 5 5+ F_
= 3] r rrr| ] l I l == j_:_‘_{
ke e 2, w2 = 7
. —— i

Observe gue as notas que estdao na clave de Sol com a haste para cima
pertence a voz 1. Com a haste para baixo na clave de sol pertence a voz 2. As
notas na clave de fa com a haste para cima pertence a voz 3 e com a haste para

baixo a voz 4.
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Porém para que a partitura polifébnica ou harménica que vocé deseje
escrever fique organizada obedecendo a posicdo das hastes, ser4 necessario

marcar a voz das notas e inverter a direcdo das hastes. Acompanhe:

Partindo do principio serd necessario antes de escrever a partitura,

selecionar a voz que ira escrever no marcador:

BWYV 1.6 Wie Schon leuchet der Morgenstern

J.S Bach

@ @:3
L
o
1
1
1
1

[

Marcadores

@@@@ Page: 4]/ 4| 1 bipI < i

Defina 1 para a voz do soprano, 2 para a voz do contralto, 3 para a voz do

tenor e 4 para a voz do baixo. Acompanhe:

Clique no marcador 1 e escreva as notas da voz do soprano

BWYV 1.6 Wie Schon leuchet der Morgenstern

J.S Bach

. et e | [ || |
oo ] 44 J é%ﬂi
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1 Clique no marcador 3

1B Page: 44| 1 QRN n
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Observe que as notas nao ficam inicialmente com a haste para cima. Isso

irh acontecer depois que for escrita a voz do contralto.

Na sequencia, cligue no marcador 2 e escreva as notas da voz do contralto.

BWY 1.6 Wie Schon leuchet der Morgenstern

J.S Bach

1 Clique no marcador 2

(REE Page: 144 Y] [ | n |

O mesmo procedimento deve ser feito na escrita da voz do tenor (marcador

3) e na voz do baixo (marcador 4).

BWYV 1.6 Wie Schon leuchet der Morgenstern

J.S Bach

: :
> : [ I I T I = i T
s e
e T |
—_—t i = : : e o
Gl Clique no marcador 4 ﬁ 2 Escreva as notas do baixo

Page: |I4//4] 1 » N, < \ m

Observe gue as hastes da linha melddica do baixo no segundo compaso
estdo para cima, sera preciso inverter as hastes. Veja como no proximo tépico.

INVERTENDO A DIREGCAO DAS HASTES

Para inverter a direcdo das hastes clique no menu Document ->
Document Options.
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@ MIDI/Audio  Plug-ins Tools Simple

v Edit Score [

Edit Part v 8
0

Manage Parts...

Page Format [
|

Data Check L4

I

Display in Concert Pitch
Display Repeats for Parts

Show Active Layer Only Shift+Alt+5

Playback/Record Options...
Sync and Video Options...

Category Designer...
Edit Measure Mumber Regions... E
Pickup Measure...

Set Default Music Font...

E> Document Options... Ctrl+Alt+A E
250 =

IrA aparecer uma nova janela, onde deve-se clicar em Layers.

Em

Settings For clique na setinha ao lado e nela aparecera Layer 1, Layer 2, Layer

3, Layer 4, que corresponde ao que chamamos respectivamente de Marcador

1 - soprano, Marcador 2 — contralto, Marcador 3 — tenor e Marcador 4 —

baixo.

I I E ol

mm

Document Options - Layers

Accidertals
Altemnate Notation
Augmentation Dots
Barlines

Beams

Chords

Clefs

Flags

Forts

Grace Motes
Grids and Guides

ﬁ Slinatures I

Lines and Curves
Lyrics
Muttimezsure Rests
Music Spacing
MNotes and Rests
Piano Braces and Brackets
Repeats

Staves

Stems

Text

Ties

Time Signatures
Tuplets

[1® 1]

-
-

1= |mf | 1 L& I |10, In !S“i IQ

Settings For: | Layer 4

1
[ Freeze ster L;;Z;z
)

d<a

Freeze ties in the same direction as stems

[7] Hide layer when inactive

[7] Adiust floating rests by: steps

[ Apply adjustmerts only f notes are in other layers
lgnore layers cortaining onfy hidden notes
lgnore hidden layers

Playback

Affects music spacing

Hep || Load Libmy.

] [ Save Library. . Units: | Inches '] [ oK ] [ Cancelar

==

Aplicar

Para organizar a posicdo das hastes,

procedimento:

1. Clique em Layer.

deve-se fazer

2. Cligue na setinha ao lado e defina a layer.

0 seguinte
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3. Marque o reténgulo “Freez stems and ties”

4. Escolha Up ou Down

5. E ao final quando definir todas as layers clique em aplicar.

6. Eem Ok
e | | e e ) AR GRS S MO WO O AN WS N
-| Document Options - Layers @
|

xg::trgarlqsmminn Seftings For. | Layer 1 h <:| z Clique em Layer 1
] ’é‘;ﬁi::?aﬁon Dots 3 E> Freeze stems and ties

E;EE Clique aqui Fecze Stems. <:I 4 Clique em Up

Freeze ties in'=~ r'ect st

(’j:lj:{;s [¥] Freeze ties in Down ion as stems

Forts [ Hide layer when inactive

gn"?:lc;eaﬁdmgilides [¥7] Adjust floating rests by: & steps

Signatures [¥] Apply adjustments anly if nates are in other layers

Li-ne-—s and Curves lgnore layers containing only hidden notes

Lyrics [ Ignore hidden layers

Multi Rest:

Musc Spacing [ Payback

Motes and Rlests [¥] Affects music spacing

Fiano Braces and Brackets

Repeats

Staves

Stems

Text

Ties

Time Signatures

Tuplets

05 Gs
Help ] [ Load Library... ] [ Save Library... Units: | Inches v] [ QK ] [ Cancelar ] [ Aplicar ]
IMPORTANTE:

Defina as Layers da seguinte forma:
Layer 1 - Up;
Layer 2 — Down;
Layer 3-Up, e
Layer 4 — Down

Apbs a definicdo a partitura fica desta forma:
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BWYV 1.6 Wie Schon leuchet der Morgenstern

J.S Bach

12EE Page: 1441 M« | m

PONTO DE AUMENTO

Clique na figura desejada, na ferramenta Dot ;J na barra de

ferramenta main e clique na partitura.
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COMPASSO

SELECIONAR COMPASSOS

Selecionar um Unico compasso

Clique na ferramenta SelectionTool e cligue no compasso que deseja.

&

@ File Edit Utilities View Document MIDI/Audic Tools Plug-ins Window Help
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Selecionar varios compassos

Clique na ferramenta SelectionTool e clique no primeiro compasso que

sera selecionado, aperte a tecla Shift no teclado e clique no Ultimo compasso.

m File Edit Utilities View Document MIDI/Audio Tools Plug-ins Window Help

B+ =+ >=2 ) > =3 % 4 & £ T %D

|
|

[oa]
39 @ @B &Hll« « H > Il @ » »il 11110000 : | Repeat: 1 Time: 00:00:00.000
oo ) J b d N NN - bbb k% g

=
© | X

[N am 3

Composer

G 2 Primeiro clique + shift & 3 Segundo clique

oo W
1]

COPIAR E COLAR COMPASSOS

Selecione os compassos desejados, conforme os itens anteriores. Va em
Edit > Copy ou Ctrl +C (copiar).
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Para colar, clique no compasso desejado e va em [ et i Tt S

B; gndoM:&sPaﬁe Cfn.z = 3 :"i
Edit > Paste ou tecle Ctrl+V. R R e =
O compasso pode ser copiado ou colado -|| @ | <T Title
o g - et Sobiit
utilizando o boté&o direito do mouse. - BT :
i E—1
INSERIR COMPASSOS Y e

Muttimeasure Rests

Para inserir compassos em uma partitura, cligue no =

referenge:
si

branco. Em seguida cligue no menu Edit = Insert Measure Stack.

compasso posterior em gue sera inserido 0 compasso em

e

Uma janela sera aberta. Nela digite a quantidade de compassos que
deseja. Clique em ok.

ot ——— . i By e o H
%lnurﬂﬂmur& T

Howmanymezsweszi| 9 c:l 1 Digite a quantidade de
compassos.

(o) (o) o

1r

ale 2010a - [coral.mus]
e dmm es View Document MIDIAudio

il

P
ADICIONAR COMPASSOS g Coriunio cutz
= Redo Measure Add Ctrl+¥Y
Jli Undo/Redo Lists... Ctrl+5Shift+Z 1t
T Select All Cirl+ & i
Select Region... =
Cut Ctrl+3
Para adicionar compassos ao final da musica i B o
Insert trl +.
H H Paste Ctrl+ =
cligue no menu Edit = Add Measure. B ey E
Usze Filter Alt+Ctrl+F
Edit Filter... Shift+ Alt+Ctrl+F l_
Mowe/Copy Layers.., =
Clear A/l terms Backspace
Clear Selected Iterns...
SmartFind and Paint 3
Text Search and Replace...

Add Measures ... :

Insert Measure Stack..,
Delete Measure Stack Delete
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Uma janela sera aberta. Nela digite a quantidade de compassos que

deseja. Clique em ok.

: : :
E PPl e R
3 ij T .I 4 J J T .! = == — £ ; 7! £
2 E } i i Add Measures @
How many measures? 2| @1 Digite a quantidade de
: cpmpassos.
[ OK H Cancel H Help ]
i

Observacao: Também pode inserir ou adicionar compassos clicando no
compasso com o botéo direito do mouse.

T T S - TS S PR I

EXCLUIR COMPASSOS e
Barline 3 C
Multimeasure Rests 3
Para excluir compasso, clique no e <9 cortar

, ) Copy ¢ Copi
icone Selection Tool na barra de ﬁ Inser %

Paste Colar

ferramenta Main. Cligue no compasso Paste Multpl..

Use Filter

desejado e va em Edit 2 Delete Measure ———=——  titen.
Stack.

Move/Copy Layers...

Clear All lterns

Clear Selected tems...

Também pode ser feito da sequinte —— ™™= ¢Adicianarm7

Add Measures.,

| 5
forma Insert Measure Stack... <:cl::1:rassos
Delete Measure Stac el
i ) e Key Signature cofpasses————
ApOS selecionar o compasso, aperte a Time Signature ,
Clef...
tecla delete no teclado. Ou ainda com o St Style >
S ——— ] Repeats 3

botdo direito do mouse. - it Beat Chart

an object to move it; Doub (e [T eI
L

APAGAR O CONTEUDO DOS COMPASSOS

Para apagar apenas o conteudo do compasso clique na ferramenta

Selection Tool na barra de ferramenta Main e no compasso que deseja pagatr.

V& em Edit 2 Clear All items ou apertando a tecla backspace.
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T P R L

Edit Measure Attributes...

Barline 3

Multimeasure Rests >

Cut

Para apagar indicacbes de expressdo, =r—

Insert

it

andamento e etc. Clique em Edit > Clear Select

Use Filter

Items. % Edit Fiter...

Move/Copy Layers...

Il

Clear All ltems
Clear Selected Items...

Add Measures...

Insert Measure Stack...
Delete Measure Stack

Time Signature >
Clef...

il

Staff Style ,

BARRA DE REPETICAO

Para colocar na partitura barra de repeticéo e indicacdo como D.C AL Fine,

D.S, Coda, ritornelllo e etc, utiliza-se a ferramenta Repeat [@ na barra de

ferramenta Main.

Ritornello

Para fazer o ritornello, clique no icone Repeat na barra de ferramenta e

dé cligue-duplo no compasso onde sera iniciado o ritornello.

w Document MIDVAudio Plug -ins  Tools Repeat Window Help
EEE@TF‘ DExE=AARD EQ

1{0000 Repeat: 1 Time: 00: .200 E = [120 : E ‘
O Ea=

Ira aparecer uma janela onde sera definido o primeiro sinal de repeticéo.
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Repeat Selectio 0 0 ==
....... — ==
e R S| E
Foward Back Back Ending
ding Edit :
TextRepeats: r
D.C. al Fine [+ E
D.C. al Coda (2)] *‘ Duplicate
D.S. al Fine @) Delete
D.S. al Coda O v
To Coda # ©) Fr—
Fine ) =
s ©
» (8)
Go To Measure # (©)
= Help

Em seguida, dé clique duplo no udltimo compasso onde serd o fim da

repeticéo.

=|rge) DExE=AARD Q)
IW Repeat: |1~ | Time: 00:00:00.000 E—[T 2 E‘
EEEEEEEU&EEEE @ =ma e

Ira aparecer a janela, onde deve-se marca o fim da repeticdo. Clique em

Select.
Repeat Selectior
ep 02 (5
-_S lect
B JJ
Fornard gk a m Ending
ﬁ Edit.
Text Repeats: 1
D.C. al Fine =
D.C. al Coda @ [(osee
D.S. al Fine 2 Delete
D.S. al Coda ] R
To Coda # (5)
. Move Down
Fine (F)
& ©
bl ®
Go To Measure # ()]
= Help

Em ok na préxima janela:



Backward Repeat Bar Assignment, Measure 3 @
Repeat Action
@ Play section: 2 e

() Jump on pass: | 1
[ Reset on repeat action

) Always jump

Target: |Nearest Forward Repeat -

Show On
All staves
Top staff only
Stafflist: Edit...

Allow individual edits per sffff for ending bracket

[ oK ” Cancel H Help

Resultado:

COMPASSSOS POR SISTEMA

COMPASSO

Para definir a quantidade de compassos por sistemas, selecione o0s

compassos. Em seguida, va no menu Utilities = Fit Measure.

Edit | Utilities | View Document MIDI/Audio  Tools Plug-ins  Window Help

Transpose..
Transpase Percussion Motes...
Respell Motes

1 o

|m|4a"m—

Mowe ta Prewious Systerm Ctrl+Up Arrow
Move to Hext Systermn
Lock Systerns Cirl+L
Unlock Systems Ctrl +Shife+L

Ctrl+Dowon Arrowy

Music Spacing
Update Layout Ctil+U
Update Smart Word Extensions and Hyphens

Rebar
Rebeam »

b §

Dpus 5

rince Ra

b ld=120

Explade Music..
Implode Music...

SmartMusic® Markers...

Add/Remove Cape Cherds...

Apply Articulation...

Check Notation 3
Stem Direction 3

Change

Change Instrument..

EEEp
=
=

cello |BEE — —=

s
< 7 &

; T
= = -
for

6
f

Aparecerd uma janela, e nela digite a quantidade de compassos por

sistema e clique em OKk.
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(@) Lock layout with: E- measure(s) per system.

Treat Multimeasure Rests as one measure
(") Lock selected measures into one system
() Remove system locks
Fit Music On

Current Part or Score A4 Select...

2

(@) All measures

(_J Measure: through:

\E

Cancel

Caso deseje alterar em toda a partitura a quantidade de compassos. E s6
ir em Edit = Fit Measure, como explicado acima, e quando aparecer a janela,
definir a quantidade de compassos, clique em All Measure (todos os
compassos).

COMPASSOS INVISIVEIS

Para ocultar compassos sera necessario clicar na ferramenta Staff Tool
localizada na barra de ferramenta Main e clicar nos compassos desejados.

Em seguida, com o botdo direito do mouse clique em cima de um dos
compassos selecionados. Quando aparecer as opg¢fes clique em 13: Force
Hide Staff (collpse).

y
m Fili Edit Utilities View Document MIDI/Audic Tools Plug-ins Staff Window Help
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Define Staff Styles...
Apply Staff Style To »

Titl Clear Staff Styles From ,
itle
Use Selected Staff Style for Score and Parts

Score

Subtitle 01. Slash Notation
2 02. Rhythmic Notation
G 03. Blank Notation: Layer 1
| 04. Blank Notation: Layer 4
05. Blank Notation: All Layers

5]
Voice

Cm\b
MY

06. Normal Notation
07. One-Bar Repeat

08. Two-Bar Repeat

09. Standard 5-line Staff
Piand? 10. 1-line Staff: Full Barline
11. 1-line Staff: Short Barline

i i1 e
“[ 13. Force Hide Staff (Collapse) I <:’|‘ 3
NetoSh

5 15. Stemless Notes

T T | 16. Lyrics and Chords Only
1 t 17
18. Blank Notation with Rests: Layer 1
i A 19. Blank Notation with Rests: Layer 4
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Pronto, os cinco primeiros compassos da voz do soprano estdo invisiveis.

Score .
Title

Subtitle Composer

Arranger

J
-4
L2
Piand?

=¥

ST

Para voltar a trabalhar na partitura é sé clicar na ferramenta Selection e

dar um clique fora na partitura.

COMPASSO ANACRUSE

O compasso Anacruse pode ser definido logo no inicio na janela Launch

Window ou no momento de escrever as notas da partitura.

Para fazer a Anacruse, clique em Document - Pickup Measure.

Document ‘Audic  Teols Plug-ins Staff Window
|7 Edit §core‘ “
Edit Part L3

)

=]
=

Manage Parts...

Page Format 4

| B €

‘ -

Special Part Extraction..,

Data Check L3

Display in Concert Pitch
Display Repeats for Parts T =
Show Active Layer Only Shift+Alt+5

[

ol

Playback/Record Options... Sll
Sync and Video Options...

Category Designer...
Edit Measure Number Region;‘.i
P Set Default Music Font...

Document Optiens... Ctri+Alt+A

i

[ T~ 3 T
| o — 1 T
=X i
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Arranger

-

N>
S

| 1088
| 1088
1T
| 100

54
[J)

Piano

o1
| TE d
%
= 3

Y

Ira aparecer uma janela, onde sera definida a figura que representa a
quantidade de tempos do compasso anacruse e cligue em ok. (No exemplo

abaixo foi escolhida a figura que vale um tempo, a seminima).

Select the duration of the pickup note(s):

Iﬂlomﬁﬁﬁﬁ
ll-| - ﬂﬂ I] ﬁ ﬁ ﬁ

EDUs 1024 Clear Pickup
2

QK Help

Em seguida, € s6 preencher o compasso anacruse.
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LIGADURAS E OUTROS SINAIS DE EXPRESSAO

LIGADURA DE NOTA

Para fazer a ligadura de nota clique no icone Tie @ localizado na Barra
de Ferramentas Simple Entry Palette, clique na figura correspondente primeira

nota que deseja fazer ligar a nota.

) G o o (o ()
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41

re)
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e = |

4

Resultado: |

=
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e, o] G

LIGADURA DE EXPRESSAO
Para fazer a ligadura de expressdo escreva as notas que deseja ligar.

Clique no icone Smart Shape @ localizado na Barra de Ferramentas Main e

no icone Slur @ na Barra de Ferramenta Smart Shape.

D Finale 2010a - [coral.mus] Iil @"&I

File Edit Utilities View Document MIDAudio Plug-ins Tools SmartShape Window Help
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Erm seguida, dé um clique duplo e segure na cabeca da primeira nota que

deseja ligar. Arraste o mouse até a nota final do ligado. Observe que a ultima

nota deve ficar selecionada, para isso posicione o ligado na cabeca da nota.

0 Quando a ultima nota estiver

Duplo clique, 2 selecionada solte o botéo do

segure e arraste.

Para inverter a direcdo da ligadura, digite Ctrl + F.

Esse procedimento serve para todos as outras ferrmentas da barra de

Ferramenta Smart Shape Palette, como crescendo,decrescendo, trinado e etc.

Smart Shape Palette

E
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DINAMICA

DINAMICA

Para colocar indicacdo de dinamica na partitura, como maestoso, allegro,

Forte e outros. Cligue na ferramenta Expression Tool

E na barra de

ferramenta Main e dé clique duplo no compasso que deseja colocar a dinamica.

Ird aparecer uma janela, onde devera ser indicado o sinal da dindmica e em

seguida clicar em Assign.

%EE “_EF—IEE VEE
1j0000 Repeat: |1 Tim ﬁOO 00.000 E =
I EEEEEEEEE E

G Clique duplo
8

5| Expression Selection

H  [Show Al 1 112 )13
B Dynamics |
Tempo Marks
Tempo Alterations W
Expressive Text 5 6
Technique Text
Rehearsal Marks m
Miscellaneous f
9 010
13 L] 14
sf

El

Edit Categories... | Dynamics: forte (velocity = 88)

-2

L Edit... ] [ Duplicate J [ Delete J [MoveTo v] [ResethoCahegory v]

[ Create Dynamic... Help ]

[ Assign _I[ Cancel
£pd

Resultado:

Adagio
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SINAIS DE ARTICULACAO

Para inserir sinais de articulacéo, cligue na ferramenta Articulation na
Barra de Ferramentas Main.

Dé um clique duplo na cabeca da nota em que deseja colocar o sinal e uma
janela serd aberta. Escolha o sinal e cligue em Select. Nesse exemplo foi
utilizada a Fermata.

+ Document MIDI/Audio Plug-ins Tools Window Help
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= = = L)
499 50y 51 » 55 56 4

A

52 L 534 B4u
- A > 3 v A ©
57 a2 58 590 604 61y 62,
T = (o] + i + -
[ Edit... ] [ Duplicate ] [ Delete ] [ Move Up } [Move Down] i‘\JgI
e, [ select | [ concel | [ Hep |

Resultado:




CIFRAS

CIFRAS

O Finale oferece algumas opcdes para escrever cifras. Vejamos:

MANUAL

Clique no icone Chord m localizado na barra de ferramentas Main.

TP Y
ullaGipad [ 1 tioooo \ ‘Repeat 1 | Time: 00:00: ooq& Al - [Tr
R o o o o o o e o |

Z#—g = =

Em seguida, dé um clique em Chord - Manual Input.

s View Document MIDFAudio Plug-ins ;@|Chord| Window Help

IEELRE LR G

w \Wlﬁ Repeat: ilivi Time: ( One-Staff Analysis

= Two-Staff Analysi

- E E E E E E E : E A‘;I-OStatf:Ana’:;s)i':ls

Chord Style 4
Left-Align Chords

[7 Italicize Capo Chords
# e 3 - Show Fretboards
L2 E [7 Position Chords
Fosition Fretboards

l7 Simplify Spelling
F Substitute Symbols

L2

| 3

1]

1]

Edit Learned Chords...
Change Chord Suffix Fonts...

l7 Enable Chord Playback




Clique acima do acorde e escreva a cifra.

1clique e

£ G digite a cifra.
T
1

—@—Q—g_—l—

fo)
)" A
F o B
D]

MANUAL (JANELA CHORD DEFINITION)

CIFRAS

Clique no icone Chord m localizado na barra de ferramentas Main.

IEELDSED

5w E A A %I

el [7719900 | | Repeat: [1 -] me: oo:o0:00 g0 [

=[=o |

R G G o e

AR R |

o5

Em seguida clique em Chord - Man

ual Input.

s View Document MIDAudio Plug-ins ,%l Chord | Window Help
Fi

ZELRSEARE
w "Wﬁ jRepeat: ‘17*' Time: (
ol o o R s

Allow MIDI Input
One-Staff Analysis
Two-Staff Analysis
All-Staff Analysis

i/ T
VA 3 } —
T

M:g

4
~
o

Chord Style

Left-Align Chords
’7 Italicize Capo Chords

Show Fretboards

W Position Chords
Pasition Fretboards

[v  Simplify Spelling
[v Substitute Symbols

Edit Learned Chords...

Change Chord Suffix Fonts...

[7 Enable Chord Playback

L2l

|

| ]

1]




CIFRAS [E]

Dé um clique duplo na cabeca da nota. A janela Chord Definition sera
aberta. Nela escreva a cifra desejada e clique em ok.

0 Clique duplo
1

h T
@ Chord Definition —
3} =
Chord Symbol: [ @ .

Fretboard
) D 1 [ Select.. | [ Edit.. | ==
¥ = Major: Standard Guitar —
: =

Style: [(New Fretboard Sty v] [Edit Styles...

Show Play
9 = [V]Root [] Alternate Bass [¥]Root =
¥ [~ Lowercase Lowercase [¥] suffix —
’ [¥] suffix After Root [T Fretboard

[¥] Fretboard [ Alternate Bass
n

C
Resultado: e :
> i
e e — —
(3] RS

INSERINDO FRETBOARDS (BRACO DO VIOLAO)

Para inserir o bracinho do violdo deve-se inserir o acorde como uma das
alternativas visto acima. E em seguida ativar no menu Chord - Show Fretboards.

View Document MIDIfAudio Plug-ins T@|Chovd Window Help

AT T T e 3

Allow MIDI Input B=i

m‘ 1] 1j0000 || Repeat: (1 | Time: ( One-Staff Analysis

i e i e e Two-Staff Analysis
Y T e

Chord Style 4

Left-Align Chords
}'v Italicize Capo Chords

fH

y i - Show Fretboards
—@3—4—§ . — .
Y] [v  Position Chords

Pasition Frethoards

ming |

(1]

1]

[v  Simplify Spelling
[v  Substitute Symbols

1]

Edit Learned Chords...
Change Chord Suffix Fonts...

(v Enable Chord Playback
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Dé um clique duplo no acorde e serd aberto a janela chord definiton, onde a cifra

serd escrita. Em Fretboard clique em Select e uma nova janela sera aberta.

, B

@ Chord Definition =
(3

Chord Symbol: E C‘j > [Advanced >> ] [ OK J
Fretboard

[ ] [ } Cancel
ID: 1 Select... Edit... = 2
o Major: Staﬁd Guitar @

Style: [(New Frethoard Sty v] {Edit Styles...]

TTTHT

Show Play
= [¥]Root [ Alternate Bass [¥]Root =
[T Lowercase Lowercase [¥] suffix =
[¥] suffix After Root [7] Fretboard
[¥] Fretboard [] Alternate Bass

Nesta janela selecione a posicdo desejada e clique em Select.

| Fretboard Selection: C == -

Copy Fretboards From Another Chord Suffix:
— oo B
oEE 3

{t,

Escolha a posigio.

3

[ Edt.. ] [ Dwicate | [ Delete | [ Moveup | [MoveDonn] ﬂg
=,

Para editar o Fretboard, clique em Edit.

{ Chord Definition =

Chord Symbol: C G [ Advanced >> ] [ OK J
Fretboard
|
D: 2 | Select.. | [ Edit.. |
Simple Major Triad: Standard Guitar ﬁ

Style: I[New Fretboard Sty '] [Edit SMES---]

Show Play

Root [ Alternate Bass Root C
] Lowercase Lowercase Suffix E

[¥] suffix After Root []Frethoard

Fretboard [T alternate Bass




CIFRAS S

Uma janela sera aberta e nela podera ser alterado a indicacdo das notas no acorde
na barra de ferramenta do lado esquerdo. Apds terminar, clique ok para todas as
janelas.

|| Fretboard Editor - ‘
Frethoard Group |:>
Name: Simple Major Triad Show Group >> -
Instrument: [ Standard Guitar v] [Ed\t Instrument. .. ] - £
:
Fretboard [
am | o1 Mumber of Frets: 4
[ Multiple items per string
&2 [ ]
Fretboard Number
Ol o3 L J
[F]show Mumber: | 1
® 4 L
x| T I ven
=
E Style: (New Fretboard Style) A
I N— Clear Items

Se o brago do violdo ndo aparecer, va em Chord e ative Show Fretboards.

View Document MIDIVAudio Plug-ins  lools | Chord | \(#adow Help
== — S |

ZELR=EEREE T
|- = Allow MIDI Input

“‘ [ ! IW ~ Repeat: 1 Time: € One-Staff Analysis
Two-Staff Analysis

E E m [I E E E E B All-Staff Analysis

Chord Style >

Left-Align Chords
|v Htalicize Capo Chords

G [ \; Show Fretboards

|v  Position Chords

Tl

W

Position Fretboards

& =
|v  Simplify Spelling
|v  Substitute Symbols
A Edit Learned Chords... |
77 =
~—F = Change Chord Suffix Fonts... =

.

}'vi Enable Chord Playback

Resultado:

e
$00




ANALISE AUTOMATICA

Cligue no icone Chord

ciFras - [T

Q_Iocahzado na barra de ferramentas Main.

tEELRESRNEwE@AL G

M 1] 1/0000 | Repeat: |1 Time: 00:00:00 AJ- [0
o I e
=

—

Ative o0 menu Chord, clique em One-Staff Analysis (para analisar uma

pauta) e em Two-Staff Analysis (para duas pautas) ou All-Staff Analysis (para

analisar todas as pautas).

Document MIDI/Audio Plug -ins T

E@

Repeat: |1

IEEEEE

JEE = Wiridcur ek m—
= v
= & et

Time: c

Manual Input ﬂ
Allow MIDI Input 3
One-Staff Analysis
Two-Staff Analysis
All-Staff Analysis

E

f

)

ef
MY

v Simplify Spelling

Chord Style >
Left-Align Chords

Italicize Capo Chords

Show Fretboards

Position Chords

Positiory Eretboards

Substitute Symbols

Edit Learned Chords...
Change Chord Suffix Fonts...

Enable Chord Playback

De acordo com a marcacao escolhida, dé um cliqgue duplo acima da nota

em que deseja inserir o acorde e 0 mesmo procedimento

Se o programa reconhecer o acorde ele aparecera no local clicado.

Se o Finale ndo reconhecer, aparecera a janela Uknown Chord Suffix,

perguntando se deseja inserir manualmente o acorde desconhecido, ou prefere

gue o Finale indique o acorde.



CIFRAS ¥/

e it e o 1 |

0 Unknown Chord Suffix ==

1

A | | 4 5 ) Finale cannot find a match in the suffix library
74— = &Y for the chord it is analyzing. —
| . TN =i Dt

LT A ARt

(3} Do you want to create a new suffix or let Finale do it?

[ oot || LetFinsleDolt | | cancel

» ,' 2 i; fa
Dl 3 r 1 T
VA 1 T
x EY (=17 | 1

Clique em:

e I”ll do it para abrir a janela Chord Definition e digitar o acorde
desejado.

e Letfinale do it para que o programa tente adivinhar o acorde.

Fazendo a opgéao por “Let Finale do It” (sugestdo do Finale), acompanhe:

oy
| ¢
|
S T - =
0 Unknown Chord Suffix @ -
I {;’ #5 Finale cannot find a match in the suffix library
W for the chord itis analyzing.
Do you want to create a new suffix or let Finale do it?
[ o1t | [ LetFinaleDolt | [ cancel
= L= |
Resultado:
Gsus
o)
H [~ =z
4+ T
U 1
4
7%




CHORD DEFINITION (ACORDES DESCONHECIDOS)

Como visto no toépico anterior, o Finale oferece a opcédo de escrever 0s
préprios acordes em Chord Definition, que também pode ser feito da seguinte

forma:

Clique na ferramenta Chord Tool e acima do acorde desejado.

EEEE LR
Aloui [
e ol

SalExEEE
Time: OO:OO:O0,0M
o TE

~ | Repeat: 1

GZ Dé um clique acima

f | do acorde.
ot =
D)
)4 | -
e i
e z

G
L& Lt
174
[+
e
Unknown Chord Suffix
o I T j
7 4 ’} { ‘0‘ Finale cannot find a match in the suffix library
e [ W for the chord itis analyzing.

Do you want to create a new suffix or let Finale do it?

[ Do1t | [ LetFinaleDolt | [ Cancel

>
ir :

Digite o nome do acorde ou procure as opc¢des em Advanced-> Select.

Chord

Fretboard

D: 1

7

T Chord Symbol:  G7

ition

1 Digite o acorde e

G

i

TTTTT

Cancel

i g

Select... Edit...

Standard Guitar

(\EAN

Show
[¥]Root

[¥] suffix

Root:

Alternate

Suffix:

Style: |(New Fretboard Sty v | |Edit Styles...

["] Lowercase
[V]Fretboard

Numeric Definition

[C]capo atFret: |0

Play

[¥IRoot

(V] suffix

[T Fretboard

[7] Alternate Bass

[T Alternate Bass
Lowercase

After Root

5

[ select... | [ edt.. | [ usten... ]

Dgé?ﬁetboard Font

Scale Tone: Alteration: 0

Bass: ScaleTone: 1 Alteration: 0

D: 25

ciFras - I




ciFras [ZCHN

Irh aparecer a janela Chord Suffix Selection. Escolha o acorde e clique

em select.
—i_{‘hard Sumbale 157 | A d L Pars ———
7| Chord Suffix Selection ==
1 2 3 16 5 . 5 . ~
& 2 6 @ maj maj6 M

7 g 9 10 11 12

maj7 maj7(add  maj7(add maj7(add maj7(b3) émaj'."(#i)
13 14 J15 16 7 18
maj7(9)  ma7(311] maj7(13) Iinaf.-‘(bli maj 9 maj3(h35)
19 20 J21 22 L23 24 |
maj2(45) éman(#ll,éma]E'(B) Mmaﬁ(bllémajlo : majl13(311

25 26
7

Y6s)  Ca@s) )

Tew Fan T Tees) Thees) Tmeen)

a7 38 ele] 40 41 42

769(13) Tha(b13)  T789(b5) T42(335) T49(311)  T7490Q13)
T 06w Fae Fomid Tomie 5 69 =
1 e San “bay e T TBes q

[ Edit... ] [ Duplicate ] [ Delete ] [ Move Up ] [Move Down] @g
2|:>[ Select ] [ Cancel ] [ Help ]

Para organizar o acorde, clique em Edit.

Chord Definition [=22a]

Chord Symbol:  G7(b8}) [ Advanced << ] [ QK J

Fretboard

D: 1t [ Select.. || Edit.. | =

o
Hel
7 (b9): Standard Guitar ﬁ

Style: [{New Fretboard Sty V] ’Edit SWES---]

Show Flay
Root [~ Alternate Bass Root
[7] Lowercase Lowercase Suffix
& Suffix After Root [C|Fretboard s
7 Frethoard [ Alternate Bass ==

MNurmeric Definition

Root: Scale Tone: 5 Alteration: 0
Alternate Bass: Scale Tone: 1 Alteration: 0

Suffix: D: 2% [ select.. | | Edit.. | [ Listen... |

[ capo atFret: | 0 [[use Fretboardﬁt

Aparecera a janeca Chord Suffix Editor, onde podera organizar a
disposicéo dos sufixos da nota.



T Chord Suffix Editor [
g Symbal. .. fi
; [ Mumber
d4 1 jﬁ[,_g) ________________ [ Prefix with
B ﬁ Flat Minus
- i Sharp Plus
: H: 0,08681
Show handles [ | Update "-"O 0,01042 O
[ Set Flay... ] l Set Font... ] [ Prev ] [ Mext ]
Times Mew Roman 11 plain
[ OK ] [ Cancel ] [ Help ]

ro

1

T

CIFRAS

O Acorde pode ser organizado utilizando os comandos next (proximo) e

prev (anterior) para alterar a altura ou largura dos elementos do sufixo do acorde.

Dai por diante € s clicar em ok e o acorde aparecera na partitura.



Letra de Musica

LETRA DE MUSICA

Para inserir letra de musica na partitura clique no icone Lyric, localizado

na Barra de Ferramenta Main.

EEEEELREAREME=(Aa kD Q|

LSt @0 0O i [1170000 || Repeat: [t~ | Time: 00:00:00.000 mﬂT: E‘ |
i i o o i o o U e

A } | I 1 T I T T I ]
== = . - - -  —
o 1 T T I i =3 =3 =2
Ative o menu Lyric = Type Into Score.

ies View Document MIDI/Audio Plug-insg l Lyrics | Window Help

=gt > Edit Lyrics... %
cZELRSaAREY e )
I R Ry 71‘ port Lyrics... A

4/»
g | i

!nEE! 1] 1joooo | = 2|1~ vl i
[ 111j0000 |~ Repeat: Tme: G Adjust Syllables

[

T T T
Edit Word Extensions
o) 1 | | Shift Lyrics...

=
Kl Type Into Score

Alignment

1 4 v |

il b

Justification

Specify Current Lyric...

Adjust Baselines...

Lyric Options...

Cligue na cabecga da nota para escrever a letra da musica.

L 188
il
oL

L 10N
N

W» Eu

Observe que ha quatro setas do lado esquerdo. Elas servem para arrastar

a letra da musica para cima e para baixo. E s6 da um clique e arrastar.



Letra de Musica

Quando terminar de escrever uma palavra, pressione a barra de espago do

teclado do computador para escrever a proxima palavra.

H& uma outra maneira de incluir a letra de musica na partitura. Acompanhe:

Ative o menu Lyric = Edit Lyric.

tled1]
s View Document MIDIAudio Plug-ins E@m Window Help
EEETR®=EED E
EEELRS AN E T O
! e g! 1] 1]0000 || Repeat: |1 Time: ( Adjust Syllables =
= ER Cx | Click Assi t.. =
e (ol G [ e tsonmen &
Edit Word Extensions
P} | 1 | Shift Lyrics...
e —
T T T T 1
v : l : ! Alignment 4
Justification 4
Specify Current Lyric...
— T — Adjust Baselines... ==
T —
; Lyric Options... [EnE

Ira aparecer uma janela, onde devera escrever a letra da masica. Lembre-
se de pressionar a barra de espaco entre as silabas da musica.

|5 Edit Lyries (= |
5 edit Tet E
€

Eu vou com ela. Eu vou sim. e

Digite o texto aqui.

Font: Times New Roman 12 plain

[ ok || canced | [ Hel

Em seguida clique em Lyric = Click Assignment.

uLg
View Document  MIDUAudio _Plug-ins 3 o8 (Lyics] Window _Help
EELRSAREE =
Export Lyrics...

SRR | 11110000 [[77] Repeat: [1 v | Time: 0y v Ghiiables
| R | Cick Assignment.._ |
ol G G G R [ (O
Edit Word Extensions
fH | 1 e, Shift Lyrics...

:'v Type Into Score

=1

w— |

T OE G

Alignment
Justification >

Specify Current Lyric...

Adjust Baselines...

Tl R

Lyric Options...



Letra de Musica

Aparecera uma janela e o mouse ficara semelhante a uma seta. Para

colocar o texto é so ir clicando na cabeca das notas.

({1 File Edit Utilities View Document MIDI/Audio Plug-ins Tools Lyrics Window Help

EEEEzERREaRExEw@AkB E1Q
E st a;,! Quid [111/0000 || Repeat: [1 Time: oooouououiL:[T, E

2 o e ol o N o o o o | o o o i o §

G Clique na nota para colocar o texto.
f

fH I |
7= t T t
e~ — e T
a5 f
) T T Vo] = = =
»» d ST P e = SR
6
0
s T T |
% : - - !
T
Dl 1] Verse 1 Click Assignment =]
[7] Auto update o
com ela. Eu vou sim.
10 B
. ]
ES '
t i t |
.

ESCREVENDO DOIS OU MAIS VERSOS

Para escrever o segundo verso, estrofe de uma musica. Sera preciso
escrever a letra da musica conforme o altimo tépico.

Para colocar o texto, ative o menu Lyrics = Specify Current Lyric.

ted1]
s View Document MIDI/Audio Plug-ins 1Window Help

TN BN = E N Edit Lyrics... =
E2ZE LD S A A s M = . i
| port Lyrics...
!7 -"= g ! ! 1] 1j0000 |- | Repeat: 71 > ﬂmé. (1 Adjust Syllables |(=
= [ . [§  Click Assignment... E
R bl el z : 4
lone Lyric —_
Edit Word Extensions
A ! Shift Lyrics... =
D" -  —
H—J—J—r—#—i—r—p—.&— v Typelnto Score =
= =z ] 1 =
L2
Al 3
Ei e | Alignment =
Justification »
‘ Specify Current Lyric... i2
i ! Adjust Baseli =
> Lyric Options... =

Uma janela sera aberta. No item type, selecione Verse. E no item

number, digite 0 nimero do verso a ser escrito. Clique em ok.

Ly
. |

Specify Cur Lyric @3
1
Type: @ Werse () Chorus () Section

Mumber:  F <:2
D ok ) [ canca | [ veb ]1

3

Concluindo o processo, é s6 clicar na cabecga das notas para inserir o texto,

como ja visto anteriormente.



EXPORTANDO COMO IMAGEM E AUDIO

EXPORTANDO COMO IMAGEM E AUDIO

AJUSTANDO O LAYOUT

Clique no icone @ localizado na barra de ferramenta Main.

Clique nele caso queira alterar o espacamento de algo. Para alterar € s6
clicar nos quadradinhos e mover.

[{7 File Edit Utilities View Document MIDV/Audio Plug-ins Tools Pagelayout Window Help
EEEEZERLRSANEEuAABr s d@EN A
Eum | 11110000 | * | Repeat: |1 ~| Time: 00:00:00.000 E= Wﬁ[‘?
| o o [ |

e o o G o

' &
2
WYV 1.6 Wie Schon leuchet der Morgenstern

J.S Bach:

IMAGEM

Para exportar clique no icone Graphics Tools. Em Grapchics cligue em
Export Pages.



lities View Document MIDI/Audio Plug-ins Tools [Grab_h—vc-s_] \:@

M 1] 1j0000 |=-| Repeat: |1 + | Time: 4 PlaceGraphlc
P T T
e ...

"ﬁ

EEELRSERE A —

EXPORTANDO COMO IMAGEM E AUDIO

Assign New Graphic to Measure
‘ v Assign New Graphic to Page

BWYV 1.6 Wie Schon leuchet der l\lorgenstern

J.S Bach

aparecer a janela Export Pages. Nela observe a quantidade de pagina e o

formato (JPEG).

Export Pages
e ;
Pages: () Al p
@ From: 1 Through: 1
File Names

() Generate names from:  C:\Users'Kadja\Desktop\Finale 2010

@) Prompt for each name

1 PostScript Options
" Indude TIFF preview Indude fonts
Allow transparency
{ Resolution: | EXH - g
[ OK ] [ Cancel ] ’ Help ]

Aguarde um pouco e logo em seguida aparecera a janela para salvar. Nela

digite o nome do arquivo e cliqgue em Salvar.



EXPORTANDO COMO IMAGEM E AUDIO

I € save JPEG I
Salvarem: || Findle 2010a.v15.152 - & m-
T X
] = |
Locais <] =
| t
frea de SeFonts% or
Trabalho
=
Bibliotecas
A {1
- 1 Digite o nome do
Computador  pome: Carto Coral <= arquive. - Salvar
Tipo JPEG File (“jpg) -] [ Cancslar |
“w

AUDIO

Clique no menu File = Save as.

I_'Utilities View Document MIDI/Audio Plug-ins Tools Graphics Window Help

1
Launch Window...

New

sl CaDEnEEEARD Q) @M

Open...
Close
Close All

Ctrl+0 ‘ Repeat: |1
Ctrl+W

Save Ctrl+S
Save All

Extract Parts...

Export to SmartMusic®...

Export to Audio File...

Post at Finale Showcase...

Revert...

ScoreMerger...
MusicXML

Scanning: SmartScore Lite

~| Time: 00:00:00.000 EJT::— E‘ ;
EEEEEEEEEEEE‘EEEEE
| Seveps. |

) Wie Schon leuchet der Morgenstern

J.S Bach

Open Finale Worksheet...

Load Library...
Save Library...

FileInfo...

TIN— %
TIve— —%

o[ e

el e

Printer Page Setup...
Print...

Ctrl+P

|

Aparecera uma janela onde deve-se colocar o no nome do arquivo e

selecionar o tipo do arquivo.



EXPORTANDO COMO IMAGEM E AUDIO

Para salvar como audio, clique em MIDI.

ﬁ

Savarem: || Finale 2010215172 - @ = m-
&) 1 %Fonts% [ atividade
"“‘} E[]'billiejeans coral
IS corall |Etras
[ musical [ piano e voz
Area de
Trabalho
=
Eibliotecas

. U

|
A l Salvar I

Computador  pgme: Canto coral

v][Ca'lcela]

Teo: (Finie Noatr Fie ¢ mus)
= Finale Motation File (".mus;
@ E,')mmm_
1 Finale Template File (*ftm) i

Al Files {°7)




